
	1	 Interface 
Fundamentals

Windows
The Media Composer interface is focused on three primary windows: the Composer, 
the Timeline and the Project. The Composer window contains the source and record 
monitors and is the place where you’ll play and mark clips or sequences. The Timeline 
displays the contents of  the source or record monitor and allows you to manipulate se-
quences, transitions and effects.

The Project, Composer and Timeline Windows.
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The Project window is divided into tabs that provide a list of  all bins, settings and visual 
effects, as well as information about project format and memory usage. Double-click a 
bin or setting to open it. Double-click an effect to apply it to a selected clip.

The three primary tabs in the Project Window:
Settings Visual EffectsBins 

Projects
Your materials will normally be organized into projects. A project is essentially a group 
of  bins and settings collected in a folder. Projects can be stored in several places on disk. 
With standalone systems they’re typically in the Documents folder in your User Folder. 
With Unity or Isis systems, projects can be shared and will reside on the server. You’ll 
normally create and access projects from the Select Project dialog box. This is the first 
thing you’ll see when you initially start up the system, and you’ll need to create a project 
and a user before you can do much of  anything.

Locate your project using 
the browse button.

Projects in this directory 
are displayed here.

Shortcuts to common 
project locations. Private 
projects are in the Avid 
Projects folder in your 
Documents folder.

To switch projects, close the Project window. The dialog box above will reappear, allow-
ing you to open another project or create a new one. For more about user settings see 
“Users and User Profiles” on page 257.

Modes and Tools
The user interface is structured around several modes, accessed via buttons in the 
timeline window. They alter the toolset in various ways, optimizing it for specific tasks. 
Source/Record Mode is the system’s basic editing environment, organized around the 
source and record monitors. Segment Mode allows you to select clips and drag them in 
the timeline. Trim Mode allows you to adjust transitions, displaying outgoing and incom-
ing video in separate windows. The Effect Editor lets you manipulate visual effects, the 
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Motion Effect Editor helps you create speed changes, and Color Correction Mode allows 
you to adjust color. 

In the past, these functions were accessed via buttons at the bottom of  the Timeline. 
They now appear along the Timeline’s left edge, whenever a clip or sequence is loaded 
into a monitor. More important, Segment Mode and Trim Mode have been integrated 
into what Avid calls the Smart Tool. When turned on, it alters the behavior of  the mouse 
cursor as you move it around in the timeline, allowing you to move clips, adjust transi-
tions, and manipulate effects or audio keyframes, all in an integrated way. Each Smart 
Tool can be independently activated; if  you leave them off, you’ll be able to work tradi-
tionally, using only the tools you need for a specific task.

Segment Tools

Keyframe Tool

Source/Record
Trim

Effects
Color Correction

Motion Effects

Trim Tools
Transition Tool

Linked Selection

Smart Tool

Modes

The Smart Tool will be covered in detail in the Timeline chapter. Trim Mode will be 
covered in the Trim chapter. Audio keyframes are covered in the Audio chapter, and ef-
fects and motion effects are covered in the Visual Effects chapter. Source/Record Mode 
is implicitly covered throughout the book. 

Bins
Bins contain your clips. They can be displayed in several views, allowing you to organize 
material any way you like. Note that each bin is stored as a separate file on disk, making 
it easier to isolate a portion of  your project and transfer it from one system to another. 

Bins displayed in Frame View and Text View.
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Use the Bin View menu, located at the bottom left of  every bin, to change bin views. 
You can now drag Media Composer windows on all four edges to resize them. A double-
arrow cursor appears to make this clear. 

Use the Bin View menu 
to change views. 

Click and drag on any 
edge or corner to resize.

Tabs

New in Version 6, bins and many windows contain tabs. They work much like tabs in a 
web browser, allowing you to dock multiple windows together inside a single frame, and 
then switch between them with a single click. 

Drag a tab from 
one window to 
another to dock 
them together.

Both bins are then 
available in the 
same frame. Click 
the tab to switch 
between them.

For more about tabs, see page 121.

Clips and Media
The Media Composer architecture makes a fundamental distinction between clips and 
media. Media are video and audio files on disk; clips are the representations of  that 
media, which you’ll use for editing. They contain the metadata associated with the un-
derlying media: timecodes, key numbers and the like. Common clip types include master 
clips, subclips, group clips and sequences. 
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Master clips typically match the duration of  the underlying media: if  you have a five-
minute master clip, you’ll find five minutes of  media for it somewhere on disk. Subclips 
are sections of  master clips, generally created to help you organize your material. For 
most editing purposes, subclips and master clips can be used interchangeably. Group 
clips are used for multi-camera editing and are created by aligning and merging multiple, 
synchronized clips into a single object. Sequences are constructed from edited source 
clips, and are the primary product of  the editing process. Each type of  clip is displayed 
with a unique icon. 

 

Master Clip 
Subclip 

Group Clip 

Sequence

Unlike some editing applications, Media Composer employs an “inheritance” model. 
When you edit a clip into a sequence and later change certain kinds of  data in the source 
clip, that data will propagate into the clip in the sequence. If  you change a clip name 
after using it for editing, for example, the new name will appear on the sequence clips. 
Subclips and Group Clips also inherit certain kinds of  source changes. For this to work, 
the bins containing the clips must be exposed to each other by being open in the same 
editing session. See “How Bin Data is Stored” on page 119 for details.

Managed and Unmanaged Media

Media Composer has long been known for its bulletproof  media management, which is 
achieved by storing all media in a specific, tightly controlled folder, usually named Avid 
MediaFiles and located at the root level of  a drive. As it starts up, the system checks 
every mounted drive for such a folder and then constantly monitors and indexes their 
contents. You should avoid manipulating Avid media at the Finder level, and instead use 
Avid’s Media Tool for that purpose (see page 215). 

The system also allows you to work with unmanaged media via what’s known as Avid 
Media Access. AMA media can be located anywhere and manipulated via the Finder, 
but with that added flexibility comes a degree of  risk. If  you move or rename files, the 
associated clip will go offline.

You can also convert AMA media to managed media via the Consolidate/Transcode 
dialog box, and point sequences from one kind of  media to the other. Modern workflows 
often entail an initial link to file-based, camera-original media via AMA and a subse-
quent transcode to Avid’s preferred file types for editing. For more about media manage-
ment see “Projects and Media” on page 213.
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Users and Settings
Media Composer derives much of  it’s power from the way it can be configured for in-
dividual use. You’ll customize the behavior of  the application using a wide variety of  
settings panels, listed in alphabetical order in the Settings tab of  the Project window. 
Double-click a setting to open it and make changes. Individual settings are covered, as 
needed, throughout the book. You can change the behavior of  buttons on the keyboard 
(p. 12), assign menu items to the keyboard for quick access (p. 66), and adjust the 
data displayed in the Composer (p. 56) and the Timeline (p. 49). You can also cre-
ate memorized Workspaces and Bin Layouts to place windows where you like them for 
specific tasks (p. 260).

Avid calls a complete group of  settings a User Profile. You can create and switch between 
profiles from the Settings tab of  the project window. This lets you move your settings 
from one machine to another and allows multiple editors to work on the same machine 
in a customized way. Note that Version 6 employs a new XML-based settings architec-
ture, and editors are strongly advised to create a new User Profile when moving from 
previous versions. For more about the settings architecture, see page 255.

Media Composer stores projects, user profiles and media in specific places, which helps 
the system provide you with a relatively bullet-proof  editing environment. Though some 
file locations can be changed, beginners are best advised to leave files where MC puts 
them.

Interface Brightness

Adjusting the overall brightness of  the interface is probably the most basic setting choice 
you can make. Select the Settings tab in the Project window and double-click the Inter-
face settings panel. Then drag the Brightness slider to the level you prefer. Text colors 
automatically invert at the darker settings. You can also change the color used to high-
light selected items. Illustrations in this book mostly employ the brightest setting with 
blue highlighting, but other options are sometimes used for clarity. 

Brightness slider.

Highlight color.

Starting Up the System

Media Composer normally presents you with the Select Project dialog box when it starts 
up, allowing you to choose the project you want to work on. If  you’d rather have the sys-
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tem automatically open the project you used last, go to the Interface settings panel, and 
select Automatically Launch Last Project at Startup.

Click here to bypass the 
Open Project dialog box 
when you start the system. 

Projects always open with all bins that were open last time. If  you prefer that bins don’t 
open, hold down the Option key while your project starts up. (You only need hold it 
down when you see the system begin to read in your settings.)

If  you start up MC and change your mind you can cancel the startup. Hold down the 
Command key and tap a period when you see the Media Composer splash screen. (One 
hit should do it, but it may take a few seconds.)

The Position Indicator
Your current location in a source clip or sequence is displayed with Avid’s venerable blue 
play cursor, known formally as the Position Indicator (and informally as the “blue bar”). 
Unlike in other editing applications, if  all Smart Tools are deactivated you can click 
anywhere in your sequence to move there, which arguably makes the interface feel more 
open. If  one or more tools are active, you’ll need to click in a timecode track or in the 
Ruler at the top of  the timeline window.

The Timeline Position Indicator. Timecode Tracks. Timeline Ruler.

Position Bars under the Source and Record 
Monitors, with their Position Indicators.

Under the source and record monitors, you’ll find Position Bars (not to be confused with 
the Position Indicator). The position bars represent your clip or sequence in condensed 
form. Like the Timeline, they display small position indicators, which allow you to move 
quickly through your material.
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Marks and Markers
With Version 6, the icons for Mark In and Mark Out have changed, and Locators have 
been renamed Markers. Though their names are now similar, their functions are quite 
different. Marks are used for editing: to identify the beginning or end of  a selected por-
tion of  material that you want to manipulate. Markers work like bookmarks, letting you 
add colored dots and text to frames, so you can easily locate them (see page 62).

Menus
In addition to the standard menu bar, the system features pop-up menus that conve-
niently bring various functions for a window together in one place. Avid calls them Fast 
Menus. You might hear them referred to as “hamburger menus,” because that’s what the 
icon looks like. You’ll find them in most windows. 

The Timeline Fast Menu. 

This book uses angle brackets to indicate simple menu picks. For example, File > New 
Bin means “pull down the File menu and select New Bin.”

Contextual

Contextual menus are enabled throughout the system. If  you have a two-button mouse, 
simply right-click on an interface item to open its menu and make a selection. On the 
Mac, if  you don’t have such a mouse, use the standard Mac keyboard shortcut, Control-
click. (Because the use of  the Control key was changed in Version 5, some traditional 
keyboard shortcuts were modified. They’ll be covered when appropriate in the text.)

The contextual 
menu for the 
record monitor. 
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Keyboard

Mac and PC

Media Composer is designed to operate identically on the Mac and the PC. For simplic-
ity, this book focuses on the Mac interface, but those of  you who are using a PC will find 
that almost everything translates over. Macintosh keyboard shortcuts are used through-
out the text. If  you’re working on a PC, substitute the Control key for the Command key 
(⌘) and the Alt key for the Option key.

Shift

In general, you’ll use the Shift key to extend a selection. To select a group of  sequential 
items, click on the first one and then Shift-click the last one, or simply click and drag to 
lasso them all. To select non-adjacent items, click the first one and Command-click each 
of  the others. You can also deselect individual items in a group by Command-clicking 
them.

Command (Control on the PC)

In the Timeline, the Command key is used to snap the position indicator from cut to cut, 
or more specifically, from head frame to head frame. You can add the Command key 
either before or after you start to drag. To snap to tail frames, hold down both the Com-
mand and Option keys, instead.

Option (Alt on the PC)

The Option key is used in combination with other commands to modify them and add 
additional features.

Delete

As in most applications, the Delete key is context sensitive and will change its behav-
ior depending on which window is active when you use it. In the timeline it will delete 
marks, markers (locators) and tracks. If  a Segment tool is active it will delete effects and 
clips. If  the Keyframe tool is active, it will delete audio keyframes. In Trim Mode it will 
delete match frame edits. And in bins it will remove clips and media files. 

Escape

In most dialog boxes, Escape (esc) is a shortcut for the Cancel button. 

Decimal Point

The decimal point key on the numeric keypad will insert a double zero (00) into time-
code or footage fields.
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Mice and Scroll Wheels
The mouse is a big part of  your connection to the system, and it’s worth spending some 
time finding the one that works best for you. I personally favor a multi-button mouse, 
where I can program a button as a double-click. You’ll probably spend a lot of  time 
double-clicking to load monitors, and doing it with a single click on a dedicated button is 
more positive and reduces wrist and forearm strain.

Using a mouse with a scroll wheel can make your work significantly easier. The Mouse 
settings panel lets you adjust scroll wheel sensitivity. The same setting also allows you to 
assign Media Composer functions to other mouse buttons.

In most windows, you can use the scroll wheel or a trackpad as you would in a word 
processor, to move windows up and down. You can also scroll horizontally with a mouse 
that supports it. This can be especially handy in the timeline. With a trackpad, you can 
typically do this by dragging two fingers side-to-side. (You may need to enable horizontal 
scrolling in Apple’s System Preferences.) But even if  your mouse doesn’t support hori-
zontal scrolling, you can still scroll left-to-right. Just hold down the Shift key while scroll-
ing up and down.

Undo and Redo
Media Composer uses a clip and sequence-based undo/redo system. You can undo just 
about anything you might want to do in the source or record monitor, but some of  the 
things you might do in a bin (including the deletion of  a sequence), can’t be undone. 
That might seem like a limitation, but the simplicity of  this approach has kept editors 
happy for years.

You can undo via the keyboard or the menu bar. Undo is Command-Z; Redo is Com-
mand-R. As you undo or redo, the timeline will change and the position indicator will 
move to show you what’s happening at every step. 

Undoing from the menu bar offers additional flexibility because it displays a list of  la-
beled undos and redos. Using the menu, you can jump through a series of  steps with 
a single menu pick. When you release the mouse button the timeline will step through 
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the intervening events in rapid succession until it brings you backward or forward to the 
event you selected. 

Step forward 
through your redos. 

Step backward 
through your undos. 

Because the undo system is sequence-based, loading a new sequence into the record 
monitor will clear the undo list. And the redo list is even more easily cleared. Doing just 
about anything new—making a mark, or even just loading a clip into the source moni-
tor—will clear your redos. 

But because some bin events aren’t saved in the undo list, it’s easy to work around this 
problem. Say you’ve made changes to a sequence that you’re not sure about. You want 
to undo them, but you’d like to preserve the current version for comparison. Rather than 
rely on redo, make a subclip of  the sequence (or a portion of  it). Then undo as needed. 
The subclip won’t change as you undo (see “Subclips” on page 124).

Another alternative is to have the system remember only record-side events in the undo 
list. To do this, select Undo Only Record Events in the Edit Tab of  Composer Settings. 
This will make the redo list more resilient; making a source mark or loading a source clip 
won’t clear it. But you won’t be able to undo anything you did in the source monitor.

Select Undo Only Record 
Events to keep source-side 
actions out of the undo list. 
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